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Formatting the
spreadsheet data

this chapter covers...
In this chapter we describe ways of formatting data within a spreadsheet using different
text fonts and styles. We also explain different ways of representing numeric data,
including currencies and dates. Page layouts will also be explained.
When you have finished this chapter and carried out the exercises which follow, you
should be competent in formatting and also printing a spreadsheet.
The concepts and techniques covered are:
■

formatting – style

■

formatting – fonts and size

■

number formats

■

cell alignments

■

date formats

■

printing and page setup

Note that the the step-by-step instructions given in this chapter are based on the
Microsoft® Excel model, but the concepts and techniques described relate to all
spreadsheet packages.
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F O R M AT T I N G – S T Y L E
Text formatting within a spreadsheet, as with other types of document, is
often used to make an item stand out or to emphasise specific data.
We will use the expenditure worksheet shown below as an example.

making data bold
To make data bold:
■

click on the required cell

then
■

click on the Bold icon on the menu bar if visible

or
■

right click on the selected cell

■

select Format cells

■

select Font

■

make the font style Bold

or
■

press CTRL and B together (hold down the CONTROL key and tap the
B key and release)

Now look at the next page to see the result.
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To make more than one cell bold:
■

select all the required cells

■

and follow the steps set out on on the previous page

using italics

To use italics in one cell,
■

click on the required cell

then
■

or
■
■
■
■

or
■

click on the Italics icon on the menu bar if visible
right click on the selected cell
select Format cells
select Font

make the font style Italics
press CTRL and I together (hold down the CONTROL key and tap the
I key and release)

See the spreadsheet screen below.
To make more than one cell italicised:
■

select all the required cells

■

and follow one of the formatting choices explained above
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underlining data
To underline data,
■

click on the required cell

then
■

or
■

or
■

click on the Underline icon on the menu bar if visible
right click on the selected cell, select Format cells, select Font and make
the underline style Single
press CTRL and U together (hold down the CONTROL key and tap the
U key and release)

To underline data in more than one cell, select all the required cells and
follow the steps set out above.
To double underline data,

■

click on the required cell

Then
■
■

Or
■

click on the drop down arrow by the Underline icon
select Double underline

Right click on the selected cell, select Format cells, select Font and
make the underline style double

note – changing back to normal text
To turn off the style, such as bold, underline, italics, you follow exactly the
same steps described above and the style will change back to normal.
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F O R M AT T I N G T E X T – F O N T A N D S I Z E
font face

The font face (often known as the ‘font’) of text is the style of the lettering:

This is Times

To change the font face:
■

This is Helvetica

click on the required cell

then
■
■

or
■
■
■
■

click on the Font face list dropdown on the menu bar if visible
select the required font face

right click on the selected cell
select Format cells
select Font

choose the required Font face from the list

To change the font face in more than one cell, select all the required cells and
follow the steps above.

font size
To change the font size
■

click on the required cell

then
■
■

click on the Font size dropdown on the menu bar if visible
select the required font face size
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or
■

right click on the selected cell, select Format cells, select Font and
choose the required font size from the list

To change the font size in more than one cell, select all the required cells and
follow the steps above.

font colour
To change the font colour:
■

click on the required cell

then
■

■

click on the Font colour drop-down on the menu bar if visible (usually
displayed as a capital A, with the current colour displayed as a bar
underneath)
select the required font colour

or
■

right click on the selected cell, select Format cells, select Font and
choose the required Colour from the list

To change the font colour in more than one cell, select all the required cells
and follow the steps above.

mini toolbar
Depending on the set up of your spreadsheet program, when you select text
to modify, you may see the mini toolbar appear, as shown below.
This toolbar provides a quick
way of getting to formatting
options which you might
require when working on your
spreadsheet. If you are using Excel, and it does not appear, you can change
this as described on the next page.
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■
■
■
■

select the File menu
select Options
select General

scroll down to User Interface Options, and check Show Mini Toolbar
on selection

To turn off the Mini Toolbar, repeat the above, and uncheck Show Mini
Toolbar on selection

F O R M AT T I N G – N U M B E R S
The word ‘format’ is used in this context to describe the way in which a
number will be displayed.

dealing with decimal places
When you enter a number into a cell it is displayed exactly as you type it,
except that any trailing zeros (zeros after the last non-zero digit on the right
of the decimal point), and leading zeros (zeros before the first non-zero digit
at the front of the number) will be ignored.
For example, if you type 0000125.76000 into a cell and press RETURN
(Enter) you will see 125.76 displayed.
If you want to see trailing zeros after a decimal point, you will need to
change the number of decimal places which are displayed.
For example, if you are dealing with money amounts, you will want to see
£34.10 rather than £34.1, which looks very odd. Therefore it is quite
common that you would want all values in a particular column or row to
display to a certain number of decimal places, to give a consistent view to
the spreadsheet.
You can see in the example at the top of the next page that several of the data
entries are displayed with only one digit after the decimal point.
(Note that throughout this example a ‘credit’ means a payment into the bank
and a ‘debit’ means a payment out – just as you would see on a bank
statement, but not in double-entry.)
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To change the number of decimal places:
■
■
■
■
■
■

select the required cells, row or column
right click on the selection
select Format cells

select the Number tab

select category Number

adjust the number of decimal places as required

You can see the effect below where the number formats for columns B and
C have been changed to display 2 decimal places.
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displaying commas in figures
In order to make numbers more readable, we often insert a comma to identify
when the number is over a thousand, and a further comma for over a million
and so on.
To display a
■
■
■
■
■
■

,

(comma) to represent thousands:

select the required cells, row or column
right click on the selection
select Format cells

select the Number tab

select category Number

tick the Use 1000 separator box

As you can see in the image below the comma can make a big difference to
the readability of the spreadsheet. Compare Column D below with Column
D on the the screen shown on the previous page.

dealing with currencies
Often when we are dealing with money it is simpler to use the built in
Format of currency for our data. A format of currency does not affect the
values but merely the way the data is displayed.
One of the most commonly used currencies is the UK pound sterling.
To display data as Currency sterling with a £ symbol
■

select the required cells, row or column

■

right click on the selection

■

select Format cells

■

select the Number tab
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select category Currency

■

adjust the decimal places as required

■

for Symbol select the £ (pound sterling) from the list displayed
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The effect of formatting columns B, C and D as currency sterling is shown
below.

If the values we had entered were euros, we could use the same procedure
as for the pound sterling (see above) and select the euro as the symbol from
the list displayed. The spreadsheet would then appear as follows:
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dealing with percentages

It is also possible to display a number as a percentage (%).
If you enter numbers followed by a % sign, the data will be recognised as a
percentage and the % sign will be displayed.
If you have a calculation, and you want the result to display as a percentage,
rather than decimals, you would use the format options to change the way the
result is displayed. For example you may want to show the closing balance
in the spreadsheet on the opposite page as a percentage of the opening
balance.
To do this, you would first insert an appropriate text description in cell D4
and then the formula =B4/B3 in cell E4 (see pages 13-14 for formulas) to
calculate the closing balance divided by the opening balance.

The spreadsheet would then look like this (note top bar and cells D4 and E4):
To make cell E4 display as a percentage:
■

select the required cell

■

right click on the selection

■

select Format cells

■

select the Number tab

■

select category Percentage

■

adjust the decimal places as required

The spreadsheet will then appear as shown at the top of the next page.
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Note: applying a format of percentage will automatically multiply the
selected cell (or cells) by 100 to create a percentage.

CELL ALIGNMENT
Alignment is used to describe the relative position of data within a cell.
With left alignment the data is shown up against the left edge of the cell.
Right alignment means that the data is shown up against the right edge of
the cell.
For centre alignment the data is positioned in the centre of the cell.
Examples of all of these are shown in the screen below. By default any text
entered is aligned to the left. Data which is recognised as a number will be
automatically aligned to the right.
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To change the way data is aligned in a cell or cells:
■
■
■
■
■

select the required cells, row or column
right click on the selection
select Format cells

select the Alignment tab

on the Horizontal dropdown select Left, Right or Centre as required

or with the cells selected
■

click on the appropriate Alignment icon on the menu bar if visible

merged cells
Sometimes we have some text which we specifically want to spread across
several cells, perhaps as a heading, and we may wish it to be centred across
these cells.
To achieve this we effectively merge the cells together to make one big cell
and then apply standard alignment options within this merged cell.

You can see in the example above that the merged cells (B6, C6, D6) are now
treated as just one cell, when selected, and this allows us to centre the text
over the three columns B, C and D.
To merge cells:
■
■
■
■
■

select the required cells

right click on the selection
select Format cells

select the Alignment tab

on the text control section click the Merge cells checkbox
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or with the cells selected
■

click on the Merge cells option from the Merge & Center dropdown
menu available on the Home menu ribbon

To unmerge cells:
■

select the required cells

■

right click on the selection

■

select Format cells

■

select the Alignment tab

■

on the text control section click the Merge cells checkbox so that it is
unchecked

or with the cells selected
■

click on the Unmerge cells option from the Merge & Center dropdown
menu available on the Home menu ribbon

D AT E F O R M AT S
There are a variety of different ways in which dates can be displayed.
The common way of describing dates is to use ‘d’ for day, ‘m’ for month and
‘y’ for year.
If we take the date of 10th February 2016, it can be displayed in the
following formats (for UK dates):
■

dd/mm/yyyy would display as 10/02/2016

■

dd/mm/yy would display as 10/02/16

To change the way a date is displayed:
■
■
■
■
■
■

select the required cells

right click on the selection
select Format cells

select the Number tab
select category Date

choose the format you require from the dropdown list

The spreadsheet at the top of the next page shows the year date amended
from 2016 to 16.
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You can also use other date formats which are available under category
Custom.

dates and time
Occasionally it is useful to include the time within a date, or even just to
show the time on its own. There are specific formats to allow for this, within
the format options. The common way of describing times is to use ‘h’ for
hour, ‘m’ for minutes and ‘s’ for seconds. The default time format is
hh:mm:ss
For example, 40 seconds after half past one in the afternoon could be
displayed as:
13:30:40
Or
01:30:40 PM
Additional date and time formats are available under the category Custom.

PA G E S E T U P A N D P R I N T I N G
Once we have created and formatted our spreadsheet it is quite possible that
we will want to print it.
Spreadsheets are not like word-processed documents – they do not
automatically fit within one horizontal page width and flow on downwards.
The first step is to see what the spreadsheet would look like when printed,
without actually printing. From the File menu, select Print. You will then see
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all the print settings which you can change, together with a Print Preview of
the worksheet on the right hand side of the screen. Alternatively, you can
select Page Setup from the Page Layout menu, then Print Preview.
If you need to make adjustments to the layout for printing, this can be done
through Settings within the Print option, or Page Setup within the Page
Layout menu.
Page Setup allows you to:
■
■
■

■

change the orientation, so if the spreadsheet is slightly too wide to fit on
one page width, you might change the orientation to Landscape
adjust the Margins – you might want to reduce these to a minimum to
give as much space as possible
select Fit to page – you can specify how many pages wide, by how many
pages tall you want to fit the spreadsheet into; it is important to make
sure that the text of the spreadsheet remains legible

check or uncheck the gridlines box if you want to see gridlines for the
rows and columns included on your printout.

The two images below show print previews where the page orientations
are:
■
■

portrait – one is taller than it is wider – like a portrait picture

landscape – the other is wider than it is taller – like a landscape painting

The image below shows a print preview where the page orientation is
Portrait.
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The image below shows a print preview where the page orientation is
Landscape.

print area
If you want to print just a particular group of cells on your spreadsheet, you
can set a print area, this could be different for each worksheet and the details
of any print areas are saved when the workbook is saved.
To set a print area:
■

select a range or group of cells

■

select the Page Layout menu

■

select Print Area

■

select Set Print Area

To clear a print area:
■

select the Page Layout menu

■

select Print Area

■

select Clear Print Area
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headers and footers

It is sometimes useful to add a header or a footer to your spreadsheet.
As you would expect a header is something which will usually appear at the
top of each page when printed, this could be something like “Company
Confidential” and the date.
A footer will appear at the bottom and is often used to include the author and
a page number if the printing covers more than one page.
To create a header or a footer:
■

select Page setup (within Page Layout)

■

select Header/Footer

■

■

either select one of the built in choices from the drop down list for the
header or footer such as page number or date
or create your own custom piece of text

An example Header, selected from the list is shown in the screen below:

An example Footer, selected from the list is shown in the screen below:

There are a number of additional items which can be inserted into either a
header or a footer, these are available if you select Custom for your header
or footer, and then pick the items you want and where you want to position
them, for example:
■
■
■
■

text

time

filename
picture

This can be seen in the image on the next page:
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pagebreak
If we wish to format our printed output so that part of the information is on
one page and the remainder on another page, we can insert what is known as
a page break.
To insert a page break:
■
■
■
■

select the Page Layout menu

click on the cell to be the start of the new page
select Breaks

select Insert Page Break.

Other packages will usually provide the same facilities presented in a
different way. We recommend that you experiment and gain an
understanding of the page setup options.
Chapter
Summary

This chapter has covered in detail the following topics:
■

formatting – style

■

formatting – fonts and size

■

number formats

■

cell alignments

■

date formats

■

page setup

You should now carry out some or all of the exercises on the next few pages in
order to practise and reinforce your learning.
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Activities
Exercise 1 – setting up a costing worksheet
In this exercise, we will create a spreadsheet, insert rows and columns, create some simple formulas, and
do some formatting. The spreadsheet will be an example of production costing.
Stage 1
This stage is about creating our basic layout.
1.

Create a New workbook.

2.

Move to Sheet1.

3.

Enter the spreadsheet title Production costs.

4.

In cell B2, C2, D2, enter No of units, Unit Cost, Total Cost respectively

5.

In A3, A4 enter Materials, Labour respectively.

6.

Insert a row between the Production costs title (row1) and the column headings (row 2).

7.

Increase the height of row 1 to 25, to make it stand out more.

8.

In cell B4 and cell B5 enter 12000 for the No of units.

9.

Enter the unit cost for materials (C4) £5.

10.

Enter the unit cost for labour (C5) £2.

11.

In cell D4, enter the formula to calculate the total materials cost for these 12000 units (=B4*C4).

12.

Similarly in cell D5, enter the formula for total labour costs.

13.

Format cells C4 to C7 and D4 to D7 as currency, no decimal places with currency symbol £.

14.

Save the workbook as T2Exercise1.

Your workbook should look as shown below:
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Stage 2
We are going to introduce some further values and do some more calculations.
1.

Continuing with the T2Exercise1 workbook.

2.

In cell A6, enter the Fixed Costs.

3.

In cell D6, enter £36000.

4.

In cell A7, enter Total.

5.

In cell D7, enter the formula to calculate the sum of the Total Cost values.

We will now work out the unit cost for the Fixed Costs.
6.

In cell B6, enter 12000 for the no of units.

7.

Enter a formula in cell C6, to calculate the unit cost for Fixed Costs (=D6/B6).

Now we have the overall total cost for the manufacture of 12000 units we can calculate the overall unit cost
based on materials, labour, and Fixed Costs.
8.

Enter a formula in C7 to sum the unit costs.

9.

Save the workbook.

Your workbook should look as shown below:
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Stage 3
Changing our layout and improving the structure of our costing worksheet.
1.

Continuing with the T2Exercise1 workbook.

2.

Insert 2 rows between the current row 2, and row 3. (This should move the current row 3 down to
berow 5.)

3.

Copy cell B5 (No of Units) into cell A3.

4.

In Cell C3 enter 12000 (or copy B6).

What we need to do now is modify our formulas so that they all refer to the one cell which defines
thenumber of units we want to produce (which is going to be cell C3), rather than having that value multiple
times within our spreadsheet.
5.

Modify the formula for Total Cost for Materials (D6) to use Materials Unit Cost (C6) and No of Units
(C3).

6.

Similarly modify the formula for Total Cost for Labour (D7).

7.

For Fixed Costs, modify the formula which calculates the Unit Cost (C8) to use Total Fixed Costs
(D8) and No of Units (C3).

The values shown in the cells should look exactly as before, as shown in the image below:

It is only the formulas which are different, as shown in the image on the next page:
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We no longer need column B, holding the repeated No of Units.
8.

Delete column B.

If, when you do this you get #REF appearing in any of the cells, it means you have not changed all the
formulas correctly, and they are still using the values in Column B. (Use Undo to put the column back, and
check each of the formulas.)
9.

Change the No of Units to 18000.

See how making one change now reflects through all of our calculations.
If we wanted to compare the effect of two different quantities at once we could do this, by copying all the
relevant cells to a new area, and the formulas will be copied.
10.

Select cells B3 to C9.

11.

Select COPY.

12.

Move to cell E3, select PASTE.

13.

Change cell B3 back to 12000.

14.

Merge and centre the heading Production Costs in row 1 across columns A to F.

15.

Save the workbook.

You can now compare the different costings for two different levels of production, as shown in the image
below.
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Exercise 2 – using percentages and decimal places
In this exercise we will create a simple spreadsheet to create the line-by-line detail for an invoice.
Stage 1
This stage is about creating the basic layout of our spreadsheet.
All text should be entered in the default typeface, font size 11, normal style.
1.

Open a new workbook.

2.

Move to Sheet1.

3.

Rename the worksheet Invoice 201.

4.

Starting in cell A1, enter the text as shown below to create the layout of the invoice.

5.

Widen column A so that all the text fits within the column.

6.

Widen column B to 18.

7.

Format the columns for Price, Total and Net as Currency, £, two decimal places (columns D, F
and H).

8.

Format discount % to percentage with one decimal place.

9.

Underline Invoice Date and Customer No. (cells A1 and A3).

10.

Enter 1/2/2016 for Invoice Date (cell B1).

11.

Enter 1498 for Customer No.

12.

Make the column headings in rows 5 and 6 Bold.

13.

Enter the details of the products sold, as shown in the table below:
Product

Description

Qty

Price

Unit

PAPER-R

Paper -Ream

4

2.15

each

PEN-50

Pens box - 50

2

9.99

each

A4FOLD-3

A4 Ring Folder - 3

3

2.50

each

PAD-1

Lined pads - 1

6

1.70

each

ENVA4-100

Envelopes A4 -100

3

10.99

each
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14.

Format the Price column (column D) to show two decimal places (no currency sign).

15.

Save your workbook as T2Exercise2.

Your worksheet should look as shown below:
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Stage 2
During this stage we are going to enter the formulas for Totals and Discount values:
1.

In the Total column, cell F7, enter the formula to calculate the Total price for the Paper item (Qty *
Price).

2.

Enter the formulas for the Total for the remaining items.

3.

Format the Total column (column F) to show two decimal places (no currency sign).

4.

Format the Discount column (column G) to percentage no decimal places.

5.

Enter Discount values of 5, 10, 5, 2 and 4 in cells G7 through to G11 respectively.

To help us do our calculations relating to the discount value, we are going to include an extra column on
our invoice which would not normally be shown on an invoice. The calculation would usually be done in
just one step, rather than two.
6.

Insert a column between the Discount and the Net columns (G and H). This column is going to hold
the calculated value of the discount.

7.

In cell H5, enter Discount, and in cell H6, enter £.

8.

Format the Discount £ column (column H) to show two decimal places (no currency sign).

9.

In cell H7, enter the formula to calculate the Discount £ for the Paper item (Total * Discount %).

10.

Save your workbook.

Your worksheet should look as shown below:
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Stage 3
We are going complete the invoice in this stage:
1.

In the Net column, cell I7, enter the formula to calculate the Net price for the Paper item (Total £ –
Discount £).

2.

Enter the formulas for the Net £ for the remaining items.

We are now going to total the invoice and add the VAT:
3.

In cell H12, enter Subtotal, and in I12, enter the formula to total the Net Values (I7 to I11).

4.

In cell H13, enter VAT (20%), and in I13, enter the formula to calculate the VAT at 20%
(=I12*20/100) or (=I12*0.2).

5.

In cell H14, enter TOTAL and in cell I14, enter the formula to calculate the invoice TOTAL by adding
the Subtotal and the VAT.

6.

Double underline your TOTAL value (cell I14).

7.

Having completed the invoice you see an error. Change the Qty of Envelopes to 6 (cell C11).

8.

Also, change the Price for pens to 10.99 (cell D8).

9.

Save your workbook.

Your worksheet should look as shown below:

formatting the spreadsheet data

59

Exercise 3 – using formatting and printing
In this exercise we will use the invoice spreadsheet created in the previous exercise to practise using
different formats.
Stage 1
1.

Open the workbook T2Exercise2 created in the previous exercise.

2.

Save the workbook with name T2Exercise3.

3.

Edit cell A5 to be Product Code.

4.

Edit cell G5 to be Discount %.

5.

Edit cell H5 to be Discount Value.

6.

Widen all columns as necessary so that column text is fully visible.

7.

Delete row 6.

8.

Format the values for Price, Total, Discount Value and Net to currency, 2 decimal places,
symbol £.

9.

Set the alignment of the column headings for Qty, Price, Total, Discount Value and Net to be right
aligned.

10.

Save your workbook.

Your worksheet should look as shown below:
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Stage 2
1.

Change the font size of cells A1, A2, A3, B3 to 12, change column widths to fit text if necessary.

2.

Change the font style of the column headings to Italics.

3.

Change the format of the Invoice Date to show just two digits for the year.

4.

Align the column heading Description (column B) in the centre.

5.

Keep the Discount% values as percentage, change to also display one decimal place.

6.

In cell A12, enter the text Euro Rate.

7.

In cell B12, enter the value 1.3 to represent the euro exchange rate, i.e. number of euros to the
pound.

8.

Enter Euro Value in cell J5 as a column heading.

9.

Enter formulas in cells J6 to J10 to calculate the Net value in euros from the £ value in the Net
column. (Net Value * Euro Rate).

10.

Set the format of cell J6 to J9 to currency, 2 decimal places, symbol euro.

You will notice that cell J9 has the value 12.99, not 13 as expected.
11.

To understand why, select cell I8, change the format to show 4 decimal places.

You can see that the value in this cell in slightly less than 10 when you show more decimal places. When
only two decimal places are shown, it is rounded up. So 9.9960 is shown as 10.00 when you are only
showing 2 decimal places.
12.

Undo this format change to cell I8 so that only 2 decimal places are shown.

13.

Save your workbook.

Your worksheet should look as shown below:
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Stage 3
In this stage we are going to look at headers and footers, and how to print the spreadsheet.
1.

Using Page Setup options, create a custom header which is to appear on our printed documents.
The header should have the date in the left section, and the sheet name (which in this case is the
invoice number) in the right section. Within the custom header section as you move the mouse over
each of the options you will see what they represent.

2.

Now create a footer which displays page number of total number of pages use page 1 of ?.

3.

Select Print from your menu.

Within the preview, you will see that not all of our columns can be seen, several column get pushed on to
a second page, to confirm this, the footer displays Page 1of 2, as shown below.
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Within Settings, change the orientation so that the page will print Landscape.

This now fits on one page, but we want to try some other alternatives.
5.

Change the orientation to Portrait.

6.

Change the scaling to Fit All Columns on One Page.
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7.

Remove the footer (set to none).

8.

Modify the custom header, in the centre section put the text Page followed by a space, then select
page number from the available options.

9.

Save your workbook.

The preview should appear as shown below:

Note:
It is useful to practise further with Print Settings, to see the effects of the many different options, also
setting up your own headers and footers.

